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Purpose and Business Overview 
 

1.1 Document Purpose 
This file layout document provides standardized data requirements and content to Bay Bridge Administrators L.L.C. 
(BBA) for assisting employer with upcoming benefit enrollments.  

This guide is designed to assist those sending employee deduction information to BBA in an electronic format. 

 

1.2 Version and Release 
This file layout guide was created on January 7, 2010. 

This file layout was last revised on July 26, 2011. 

 

1.3 Business Usage and Definition 
Employers that use BBA’s online enrollment platform can assist their employees by sending BBA census and payroll 
deduction information electronically. 

This guide can be used in the following ways: 

1. Employers electing to use BBA’s online enrollment platform can send data in this format to pre-load the 
platform prior to open enrollment. 

2. Employers that submit paper deduction registers on a regular basis (i.e. Monthly, Weekly, etc.) can send 
data in this format in lieu of mailing costly paper reports. 

3. Employers that require Section 125 “Cafeteria” pre-printed forms must submit data in this format. 

 

1.4 Information Flow and Submission 
Electronic data can be submitted to BBA using a method listed below.  Please encrypt data prior to sending it to us.  
Our public PGP key is available on our web site under the Forms section.  
 http://www.baybridgeadministrators.com/common_docs/BBA_PublicKey.gpg 

1. Employers may securely transmit their electronic files directly to BBA by using our “Upload File” process 
located on our web site at www.baybridgeadministrators.com.  See Section 4 for details. 

2. Employers may e-mail their encrypted electronic files directly to BBA by sending them to 
Enrollments@bbadmin.com.  Please coordinate with BBA on encryption scheme prior to sending. 

3. Employers may send files via File Transfer Protocol (ftp) to BBA’s ftp server at ftp.bbadmin.com.  This 
method requires prior coordination with BBA to setup an ftp account.  Please call 800-845-7519 and ask 
for Chris Stansbury or Patrick McGuirk. 

4. Employers may mail 3 & ½ inch diskettes or CD’s containing the encrypted electronic files.  Please 
include a contact person that BBA may call if we have any questions concerning your data. 

US Postal Mail Overnight 

Bay Bridge Administrators, LLC 

Attn: Electronic Enrollment Dept. 

PO BOX 161690 

Austin, TX 78716 

Bay Bridge Administrators, LLC 

Attn: Electronic Enrollment Dept. 

1101 S. Capital of TX HWY, E-200 

Austin, TX 78746 
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File Layout Overview  
 

2.1 Introduction 
BBA provides file layouts for three (3) general types of data:  

1. Employee Census 

2. Deduction or Benefit Listing (Optional) 

3. Employee Dependent Census (Optional) 

 

2.1 Important Information Regarding Files, Records and 
Fields  

The following information applies to all format, record types, and fields: 

• In recognition of the varied technology capabilities of employers, this data request will be  accepted in 
any of the following formats:  

o ASCII Tab Delimited 

o Comma Delimited “CSV” 

While Excel is commonly used, we note that it is not a recognized format under this guide.  However, 
you can save Excel worksheets as a tab delimited file or CSV.  See Section 3.5 and Section 3.6 for 
instructions. 

• ASCII files should be tab “0916” or comma delimited, with no spaces between the data element and 
delimiter at either end. 

• Regardless of elected format, the first record must contain the column headers.  

• In order to maintain file layout consistency, all fields, including NULL fields, must be provided.  NULL 
fields should contain no values/spaces between delimiters. A NULL value is reported as two delimiters 
with no embedded spaces, as follows: ,, 

• File transmissions should be made via a secure protocol. FTP with PGP encryption is recognized as a 
best practice for automated transmissions and a secure upload/download with TLS/SSL is recognized as 
a best practice for online/manual transmissions. 

• File name should be set with type, employer name, creation date, and file extension (“.csv” for comma 
and “.txt” for tab).  A date/time stamp is important in case replacement files are created.  

Format: Type_EmployerName_CCYYMMDD_HHMMSS.ext 

Example:  EMP_SmartISD_20100115_110503.csv (Employee File) 

 BEN_SmartISD_20100115_110824.csv (Deduction/Benefit File) 

 DEP_SmartISD_20100115_111548.csv (Dependent File) 

 

• Fields followed by one asterisk (*) are required. Fields followed by two asterisks (**) are conditionally 
required.  Fields without an asterisk are requested, but optional 

• All “Required” date fields must be reported. Any “Optional” date field may contain a valid date or be 
NULL (two delimiters with no embedded space) indicating that the date is not available. 

• Any “Required” TEXT field can not be reported as NULL. 

• Any “Optional” field can be reported as Null or a valid value. 
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• All Text/alpha-numeric fields can include ASCII characters from 2016 thru 7E16 which should include A-Z, 
a-z, space, and a few symbols.  See [http://en.wikipedia.org/wiki/ASCII] for more information. 

• All numeric fields should have an explicit decimal point. The format for amount fields is “11.2” meaning 8 
significant digits to the left of an explicit decimal point and two digits to the right of the decimal point; in 
total occupying at most 11 positions.   All negative numbers should have a “-“ sign in the first position of 
the field. 

Examples of acceptable numeric values include: 

o |0.00| 

o |0.01| 

o |1.0| 

o |1.23| 

o |12345678.12| 

Examples of unacceptable numeric values include: 

o || (invalid; when a numeric field is required, it can not be reported as NULL) 

o |.| 

o |0| 

o |1| 

o |.0| 

o |0.| 

o |.00| 

o |00.| 

o |0.0| 

o |1.234| 

o |12345678901.45| 

 

• All text/alpha-numeric fields should be left justified. 

• All numeric fields should be right justified. 

• All date fields should be formatted as MM/DD/CCYY. They should include leading zeros, four digit years 
and slashes for delimiters. 
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2.2 Employee File “EMP” * Required      ** Conditionally Required 

Name 
Max 

Length Format Example Comments 

1. Employee ID 12 Text E54254245TY 

Unique identifier for each 
employee record.  Not social 
security number.  May be payroll 
id. 

Note: Duplicate Employee IDs will 
cause your file to reject 

2. SSN * 11 Text 001-23-4567 

Social security number unique to 
each employee record.  Dashes 
optional.  Include leading zeros.   

Note: Duplicate SSNs will cause 
your file to reject 

3. Last Name * 50 Text AIKMAN Employee’s last name 

4. First Name * 50 Text TROY Employee’s first name 

5. Middle Initial 1 Text F Employee’s middle initial 

6. Address * 50 Text 1234 Main Street Home address of employee 

7. Address 2 ** 50 Text  2nd Address line (if needed) 

8. City *  50 Text AUSTIN Employee’s City 

9. State *  2 Text TX 

Employee’s State code.   

See US Postal Service for a 
complete list. www.usps.com 

10. Zip * 10 Text 76543-1234 
Zip code may have 5 or 9 digits.  

Hyphen is optional. 

11. Date of Birth * 10 Date 02/05/1946 Employee’s date of birth 

12. Date of Hire * 10 Date 09/01/2001 

Employee’s employment start 
date 

Note: Date of Hire cannot occur 
before Date of Birth 

13. Date of Termination **  10 Date 12/31/2004 
Conditionally required if 

Employment status is not Full or 
Part-Time. 

14. Campus Code** 6 Text L4852 

This field contains the campus 
code.  Some groups refer to this 
field as a location code, division 

code or building code.   

Note: If pre-printed election forms 
need to be sorted by campus code, 

then this field will be required. 
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15. Payroll Frequency * 2 Text 26 

Employee payroll frequency per  
calendar year 

12 - Monthly 

24 – Semi-monthly 

26 - Bi-weekly 

52 – Weekly 

Non-Standards Code 

9 – Nine Month Employees 

16. Deduction Frequency 2 Text 24 

Employee deduction frequency 
per calendar year.   

Note: Some employer run payroll 26 
times per year, yet they run 

deductions 24 per times per year. 

17. Income Annual * 11.2 Numeric 31780.00 
Projected annual income.  Do not 

list hourly rates nor monthly 
amounts 

18. Telephone 12 Text 512-327-6481 Employee’s home telephone 

19. E-mail 80 Text JohnDoe@mac.com E-mail address of employee  

20. Occupation 50 Text Teacher 
Description of the employee’s job 

title, grouping or other job 
description 

21. Sex * 1 Text M 
M- Male 

F- Female 

22. Marital Status 1 Text M 
M – Married 

S- Single 

23. Employment Status * 1 Text F 

Employment Status 

F- Full 

P – Part-time 

R- Retired 

24. Years of Service 11.2 Numeric 12.5 

Total years of service worked for 
current employer.   

See IRS publication 571 for detail 
analysis and examples of calculating 

years of service. 
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2.3 Deduction/Benefit File “BEN” * Required      ** Conditionally Required 

Name 
Max 

Length Format Example Comments 

1. Employee ID 12 Text E54254245TY 

Unique identifier for each 
employee record.  Not social 
security number.  May be payroll 
id. 

2. SSN * 11 Text 001-23-4567 
Social security number.  Dashes 
optional.  Include leading zeros. 

3. Employee Full Name * 50 Text AIKMAN, TROY Employee’s full name 

4. Deduction Code * 6 Text 0842 
Payroll deduction code for a 
deduction, reduction, or employee 
benefit 

5. Deduction Name * 50 Text Humana Cancer 

Description or common name of 
the deduction.  May also include 
name of vendor.  Typically printed 
on employee pay stub. 

6. Amount Employee * 7.2 Numeric 235.12 

The deduction amount paid by the 
employee through payroll via a 
salary reduction agreement.  The 
amount must be in the frequency 
listed in item #7.  For example, if 
this amount is a monthly 
deduction, then item #7 must be 
12. 

7. Deduction Frequency * 2 Text 12 

The number of employee paid 
deduction (#6) in a calendar year.  

12 – Monthly 

24 – Semi-monthly 

26 – Bi-weekly 

52 - Weekly 

8. Cafeteria Plan Status * 2 Text Y 

Is the Employee’s deduction 
sheltered pre-tax under a Section 

125 “Cafeteria Plan” 

Y – Yes 

N - No 

9. Amount Employer  7.2 Numeric 480.00 

Employer paid amount.  If none, 
set to 0.00.  The amount must be 
in the frequency listed in item #7.  
For example, if this amount is a 
semi-monthly deduction, then item 
#7 must be 24. 

10. Amount Total 7.2 Numeric 715.12 
Total of employee (#6) and 
employer (#9) paid amount. 
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11. Plan Type ** 10 Text 403b 

If providing data for our Tax 
Shelter Annuity Service, then this 
field is require.  Otherwise leave 

blank.  Acceptable values include: 

403b 

403b_roth 

457 

457_fica 

12. Product Type ** 10 Text Annuity 

If providing data for our Tax 
Shelter Annuity Service, then this 
field is require.  Otherwise leave 

blank.  Acceptable values include: 

Annuity – 403(b) 

Mutual – 403(b)(7) 
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2.4 Dependent File “DEP” * Required      ** Conditionally Required 

Name 
Max 

Length Format Example Comments 

1. Employee’s SSN * 11 Text 023-45-6789 
Employee’s SSN.  Must match to a 
single employee record in 
employee file 

2. Last Name *  30 Text KIRK Dependent’s last name 

3. First Name * 30 Text JAMES Dependent’s first name 

4. Middle Initial 1 Text T Dependent’s middle initial 

5. Date of Birth * 10 Text 01/15/1980 Dependent’s date of birth 

6.  Relationship to Employee * 10 Text CHILD 

Dependent’s relationship to 
employee. 

SPOUSE 

CHILD 

7.  SSN * 11 Text 003-54-9876 

Dependent’s Social security 
number.  Dashes optional.  Include 

leading zeros. 

Note: Duplicate dependent SSNs will 
cause your file to reject 

8. Sex * 1 Text M 
M- Male 

F- Female 

9. Full time student 1 Text N 

Currently enrolled as a full time 
student? 

Y – Yes 

N- No 

10. Marital Status 1 Text S 
M – Married 

S- Single 
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Sample Files 
 

3.1 Introduction 
Below are a few screen shots depicting sample files as viewed from within Microsoft Excel and as viewed 
using a text editor, such as notepad.   

You can also download sample data files from our website at the following URL.  The download file is a zip 
archive containing three (3) sample files. 

http://www.baybridgeadministrators.com/common_docs/BBA_SampleFiles_20100305.zip 

 

3.2  Sample Employee File “EMP” 
Screen Shot from Excel 

 
Screen Shot from Text Editor 

 

 
3.3  Sample Deduction File “DED” 
Screen Shot from Excel 
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Screen Shot from Text Editor 

 

 

 

3.4  Sample Dependent File “DEP” 
Screen Shot from Excel 

 

Screen Shot from Text Editor 

 
 

 

3.5  How to Save Excel Worksheet as a CSV file 
 

If you are able to get your data into Excel, then saving to comma separated values “CSV” is only a few steps 
away.  Follow the steps listed below for saving an Excel worksheet into a comma separated values “CSV” file. 

1. Choose Save As from the File menu. (If you are using Excel 2007, click the Office button and choose 
Save As.) Excel displays the Save As dialog box. 

2. In the Save As Type drop-down list at the bottom of the dialog box, choose the CSV (Comma 
delimited) option. 

3. Use the other controls in the dialog box to specify a file name and location. 

Format: Type_EmployerName_YYYYMMDD_HHMMSS.ext  

Example:  EMP_SmartISD_20100115_110503.csv (Employee File) 

 BEN_SmartISD_20100115_110824.csv (Deduction/Benefit File) 

 DEP_SmartISD_20100115_111548.csv (Dependent File) 
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4. Click on Save. 

5. Excel may display a dialog box telling you that not all Excel features can be maintained in the format 
you have chosen. Click on Yes to continue saving the information in CSV format. 

 

3.6 How to Save Excel Worksheet as a Tab Delimited 
text file 
 

If you are able to get your data into Excel, you can copy the Excel cells over to Notepad, which should create 
an ASCII Tab Delimited file.  To continue, please follow the steps listed below for converting an Excel 
worksheet into a Tab Delimited file “TXT” file. 

1. Verify your data has a header row. 

2. Select all the rows and all of the columns in your worksheet.  Be sure to capture all of the header 
records.  See screen shot below 

 

 

Be sure to get the header row and the last column. 

 

 

3. Choose “Copy” from the Edit menu.  

4. Click on the Start Button (located in the bottom right corner) and select “Run.”  Type in “Notepad.exe”  
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5. Choose “”Paste” from the Edit menu.  

 

6. You should now have a tab delimited file.   

 

7. Check for your header row and field names. 

 

8. Please save.  Choose “Save As” from the File menu.  
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9. Use the other controls in the dialog box to specify a file name and location. 

Format: Type_EmployerName_YYYYMMDD_HHMMSS.ext  

Example:  EMP_SmartISD_20100115_110503.txt (Employee File) 

 BEN_SmartISD_20100115_110824.txt (Deduction/Benefit File) 

 DEP_SmartISD_20100115_111548.txt (Dependent File) 
 

10. Click on Save. 
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Upload File Transmission Method 
 

4.1 Introduction 
In an effort to provide an easy method of transmitting files to BBA securely, we have setup a process to 
securely transmit files to us.  The Instructions below will walk you through the steps. 

 

4.2 Steps to Use Upload File 
 

1. First navigate to our web site at www.baybridgeadministrators.com using your web browser of choice, 
such as Internet Explorer, Mozilla Firefox, and Apple’s Safari. 

2. On the left side of the page select the “Forms” buttons and scroll down to the bottom of the page to 
display the “Upload File” button.  See screen shot below. 

 

 

3. Clicking on the “Upload File” will bring up a new web page to complete. 

a. In the Message box, please type us a short note stating the name of your employer and their 
reason for sending the files. 

b. In the Name box, please enter your name. 

c. In the Email box, please enter your email address. 

d. In the File to Send box, click on the Browse button and select the file you wish to send. 

e. If you need to send additional files, please click on the “Add Another” button and repeat step 
3(d). 

f. Below the files, you will need to enter the symbols from the picture in the box below. 
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g. Click “Send” to finish the process.  See screen shot below. 

 

 

4. As soon as the file upload process has been completed, our team will receive an email notification of 
the file upload. 

 


